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Plotting Data

A. Files: typeperfl.csv, typeperf2.csv, etc
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What i1s Matlab ?

#MATLAB® is a high-performance language for technical computing.

@1t integrates computation, visualization, and programming in an easy-to-
use environment where problems and solutions are expressed in familiar
mathematical notation.

#MATLAB stands for matrix laboratory.

#“MATLAB is an interactive system whose basic data element is an matrix
(array) that does not require dimensioning.

uThis allows you to solve many technical computing problems, especially
those with matrix and vector formulations, in a fraction of the time it would
take to write a program in a scalar non-interactive language such as C or
Fortran.

Starting Matlab

» Windows: Start menu = Matlab > Matlab

» Unix: Terminal window-> type matlab
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Matlab Help

1. Using HELP menu - MATLAB Help
HELP = Using Help Browser

2. >>helpdesk  Opens the Help browser.

3. >> help commandname/toolboxname/functionname

Ex: >> help sin

4. >> doc commandname/toolboxname/functionname

displays the detailed info in the Help browser.

Ex: >> doc sin

Other commands:

5. >> lookfor = helpdesk -> search

|. Matlab Programming




Matlab Variables

A MATLAB variable is essentially a tag that you assign to a value in memory.
MATLAB does not require any type declarations or dimension statements.

When MATLAB encounters a new variable name, it automatically creates the
variable and allocates the appropriate amount of storage.

If the variable already exists, MATLAB changes its contents.

Variable names consist of a letter, followed by any number of letters, digits, or
underscores.

MATLAB uses only the first 31 characters of a variable name.

MATLAB is case sensitive; it distinguishes between uppercase and lowercase
letters.

MATLAB stores variables in a part of memory called workspace.

To view what is stored in a variable type its name.

Types of Variables: MATLAB provides three basic types of variables:
Local Variables
Global Variables

Persistent Variables 7
Matlab Variables
Rules for variable names: Syntax:
=Make Sure Variable Names Are Valid varialeName=Value;
=Don't Use Function Names for Variables
Example:
=Check for Reserved Keywords
R : : >> a=5;
=Avoid Using i and j for Variables
>> pb=7;
>> c=a+b
How to remove a variable from workspace: >> method=*linear”
>> clear variableName
>> clear - removes all variables from the workspace (!!!!)
ans = default variable, when the result is not assign to a variable
Exercise: 1. Define al=8 and b2=8, cl=al+b2
2. Other commands: variable=input(‘prompt’) (>>help input)

>> a3=input(“a3=°) 8




Operators

Expressions use familiar arithmetic operators and precedence rules.

+ bddition

- Jubtraction

* Multiplication

/ Division

% Left divi=zion (described in "Matrices and Linear Algebra™ in the
” Power

! Complex conjugate transpose

[ Specify evaluation order

9
Matlab Functions
1. Standard elementary mathematical functions
>> help elfun
Trigonometric (sin, cos)
Exponential (exp, l1og)
Complex (abs, angle)
Rounding and remainder (round)
7. Elementary matrices and matrix manipulation.
>> help elmat
i 3.14159265. . .
= T Sl
3. Specialized math functions. 1 Same as i
>> help specfun == ST S
Inf Infinity —
Nan Not-a-number

10




Statistics

mean, std, min, max

Given: avector x

- average or mean value

Syntax:
M = mean(x)
S = std(x) - returns the standard deviation

min_x = min(x)
max_x=max(x)

Example: open the file myStatistics.m

Advanced:
Statistics for multidimensional data sets
Statistics toolbox

- the smallest element iIn X
- returns the largest element in Xx

myStatistics.m

myStatisticsl.m

11
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Matrix & basic matrix functions

1. Type the matrix
2. Use Specialized Matrix Functions

tolumn

(1,1 (L2 (1,3 (1,4)
(2,13 (2,2)] (2,3)| (2,4)

row

(3,13 (3,2)] (3,3)| (3,4)

(4, 1) (4,2]] (4,3) ] (4,4)

[HN
w

Define a matrix

1. Type the matrix

u Separate the elements of a row with or

@ Use a semicolon, ; , to indicate the end of each row.

@ Surround the entire list of elements with L1
3 =10 O
S=|-10 O 30
0 30 -27

1. > S=[3 -10 0; -10 0 30; 0 30 -27]

Basic matrix information: size (size of a matrix)
>> [m,n] = size(X) 14




Matrix: Accessing Matrix Elements

- |

individual element {1 2 3}
ans = A=
>> A(2,2) - 20 11 20 30
column
ans = "
. (colon) = all elements
> AG,2) 2 (coton)
20
row
ans =
> A2,:1)) ——»
11 20 30
group of elements
>> A(2,1:3) — |3 7
11 20 30

first element : step: last element

15

Matrix: Operations

+ hAddition

- Subtraction

+ Multiplication

4 Divi=zion

Y Left division (described in "HMat

- Pawer

! Complex conjugate transpose

[N Specify evaluation order
= ||

L Element-hy-element multiplication
vy Element-hy-element division

a4} Element-hy-element left division
. Element-hy-element power

ol Unconjugated array transpose

A+B
A-B
A*B
A/B
A\B
A"B

A*B
A./B
A\B
A"B
Al

16




Matrix: Operations

10 20 30
>> A*B l

2 3

3 1|, B=[11 21 31|,
2 2 1 2 3 ans =
35 68 101
>> A=[1 2 3; 23 1; 2 2 2]; o

>> B= [10 20 30; 11 21 31; 1 2 3];

>> A_*B
a; ap bn b12 b13 l
A_ a21 a22 ] B_ bZl 22 b23 1
ans =
d; dg 32 b33
10 40 90
an'bu a, b, a;- b13 22 63 31
A*B=|ay by, a,-b, a;-by, 2 4 6
ag; - b31 as, 'bsz Qg3 - b33

17

V. Matlab Programming
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M-files

i Files that contain code in the MATLAB language are called M-files.

i You create M-files using a text editor.
i Use a M-file as any other MATLAB function or command.

i A M-file is a plain text file.

Two kinds of M-files:
Scripts
do not accept input arguments or return output arguments

operate on data in the workspace.
Functions

can accept input arguments and return output arguments

internal variables are local to the function.

>> edit FfileName

>> edit exSwitch

19

Plotting
plot
Sintax:
plot(y); plot(x,y); plot(x,y,s)

The plot function has different forms, depending on the input
arguments.

If v is a vector, plot(y) produces a piecewise linear graph of
versus the

If you specify two vectors as arguments, plot(x,y) produces a
Versus

20




Plotting

plot(x,y, S);

S allows to plot :

colors, symbols, different lines

b blue
g green o
r red X
c cyan +
m magenta *
y yellow S
k black d

point - solid

circle dotted
x-mark -. dashdot
plus -- dashed
star (none) no line
square

diamond

plot (X,y,"c+:")

plots a cyan dotted line with a plus at each data point;
21

Plotting

clear

t=0:0.01:10; % time seconds
signalSin=sin(2*pi*t); % signall - frequency =1 Hz
signalCos=0.5*cos(2*pi*t); % signal2 - frequency =1 Hz

figure

plot(t,signalSin);

hold on

plot(t,signalCos,

xlabel("time");
legend("Sin-,

"Cos");

“xr);

plot2signals.m

ylabel("signal");

title("Two Signals®, "FontSize",12)

Other commands:

figure

xlabel
legend, title
ylabel

22




Plotting

Two Signals

signal

Lok ek
T RO

10
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Visualization

- Interactive editing

u Figure 1

File Edit View Insert Tools Deskbtop Window Help

Dede Kh|RaOe € 0H| =

O

— » show plot tools

Figure Palette

J Figure 1

Misw  Insert

Axes subplots

Lineseries selected Figure Plot Browser

Figure Palette

w Rlew Subplots

l:l 20 Axes

1. 30 Axes

w ariahles

'j/

Plok Browser

[ Axes (hotitle)

¥ sxes (notitle)
=

H = 13200
FH saong 1x400

bl 1x400
= 1x200

W Annotations
\ Line
\ Arron

™o Mowikls Arvasas

Property Editor - Lineseries

Display Mame: |

Plot Type | Line =1

Inspector

¥ Data Source: | =long

 Data Source: | 1

Z Data Source: |

KINEINE

e

Property Editor displaying linesafies
properties

Click to add data to
axes

Click to display Property
Inspector

24




Visualization

plot, plotyy, stem, subplot

plot(Y)
plot(X1,Y1,...)
plot(X1,Y1l,LineSpec,PropertyName*® ,PropertyValue,...)

plotyy (X1,Y1,X2,Y2) plots Y1 versus X1 with y-axis labeling on the left and
plots Y2 versus X2 with y-axis labeling on the right.

stem (X,Y) plots the data sequence Y at the values specified in X.

suplot (m,n,p), breaks the Figure window into an m-by-n matrix of small
axes, selects the p-th axes for for the current plot

25

Visualization

%%%%% plot commands 9%%%%%%%%%%%%%%%

t=1:1:20; x=sin(t/5);
y=0.01*x.*exp(-t); see: testPlot.m

figure

subplot(2,2,1)

plot(t,x,"--rs","LineWidth",2, MarkerkEdgeColor®,"k",...
"MarkerFaceColor®,"g", "MarkerSize~,6);

title("Plot 17);

subplot(2,2,2)
stem(t,X, " —-rs”,"LineWidth",2);

title("Plot 27)
subplot(2,2,3);
bar(t,x); title("Plot 3%)

subplot(2,2,4)
plotyy(t,x, t,y); title("plotyy”) 26




Visualization

Line Plots Bar Plots 3D Surface Vector Fields
<\ Plot Catalog
- Plot Types Plat Types Flot Types Plat Types
Plotted Variables: 5 *
f\/-\/ Pl m har L,_/ surt ,\\\;ﬁlﬂ feather
Categories
W plotyy SUHfc
Line Plots barh COMpass
Stem and Stair Plots '
Bar Plots M semilog: m - surfl S ; \| quiver
Scatter Plats ANNY
Fie Charts _ PN,
Histograms e S‘ barh mesh J._“{’ quivers
Palar Plots
Cort
ortour Fiots Ioglog hist streamslice
Images
3D Surfaces ’
“Yolumetrics area E & pareta ULt -§’_—/ streatnling
wector Fields '
Analytic Plots JH*IV’ M E
Brrerhar el ] plotmatriz vtz fal —C:f—__ streamribbon
1 E
: g plot3 ribbion :
L\/ E'&-’:- streamtube
b 1 -
comet contour3 3 -
': = coneplot

Publishing a script to HTML

& Polynomial fitting
El:ﬁt(‘.lr - I‘\Trainingl'—a.llﬁﬁw32' File Edt Wiew Go Debug Deskbop Window Help
- b O & M Location: | Z:TrainingF ali6ma32:

Polynomial fitting

D E| +B2Bo | & Contents

&= +% L% l% = 10 + = + Generate data
« Polynornial fitting

Publish ko HTML fnomial £itting + Plat fitting results

File Edit Text Go Cel Tools Debug

2 Generate data
3 %% Generate data
clear; close
4 - wolear; claose x = (0: 0.1: 4);
v = erfix):;
5 - ¥ = (0: 0.1: 4): figure
- e = A o plotix,¥, 'ho'); disp('press any ke

press any key to continue

o
0.9 o

na 8]
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Importing and Exporting Data

A\

using the Import Wizard

save, load
dimread , dimwrite
xlsread, xlswrite

fopen, , fscanf, fprintf

VvV V. V V VY

importdata

Importing Data

1. Using the Import Wizard with Text Data
File > Import Data
or >> uiimport

Fl=N Edit Debug Desktop Window

Mew N o | N imgart Wizard
Fle Bt Vew Debug Debop Weddl gowct consm Separstons)
Open... CrH0 D&k @« o (Ko e OSemcoon OTs O trer Mstor o oot hoader ez | 0%
Close Command Window {oricats [ Lew o ol et Mo ) : -
- Froviy of L W slOUOML_LabCodesdatal stisimdad 33
o B- Il £9000 2| | deenTanCiedmeea
1 !IO E7191,91094 1 2
Save kspace As... i FeTvee | Lo 65555, 00431 : o e
croatoFigure VTR | iE Skl - e B
Set Path... M-l 40 62736.08007 3 ECT
M:fia 50 61524, 08153 4 30 Ba075:462
Preferences... b g 0 0427, 42109 5 062736 060
i 38 File || wiihidgd o 50 152408
7 dutaTabDabmitedl it T Fae [0 ERN8S 1077 7 W EMz A
Page Setup... a0 525{1.3503: = e
Print. 2 SERSEIEEN 5 50 88537 2500
100 10 90, ST
Prlnt Selectlonl - 110 E&324.55059 1" 10’ ey

1C AetractDataPart2.m
2. h\ewiractDataPart2_vl.m

2 Supported File Formats

Wizard: missing data: NaN (Not-a-Number.)




Importing and Exporting Data

‘File Format

MATLAE formatted
Taut

2 Supported File Formats

Extended Markup
Language

Audio

Movie

Scientific data

Spreadshest

Graphics

‘File Content

Saved MATLAB workspace
Text
Text

Delimited text
Cormma-separated nurmbers
AML-formatted text
MNeXT/SUM sound

Microsoft WAVE sound

Audiofiden

Data in Comman Data Format

Flexible Irnage Transport Systerm
data

Data in Hierarchical Data Format

Excel worksheet
Lotus 123 worksheet
TIFF image

FNG image
HDF image
BMPF image
JPEG image

Extension

Jmat
any
any

any

.au

LCiff

Functions

load, save

textscan

textresd

cevread,
csvwrite

auread,
auwrite

wklwrite

imread,
imurite

Processing Experimental Data for the Project

A W N B

Data Preparation
Import Data in Matlab
Process Data

Plot Data

A. Files: typeperfl.csv, typeperf2.csv, etc

B. Files: logFilel.dat, logFile2.dat, etc

codel.m

code2.m

32




1. Data Pre

paration

1. Open as Text (typeperf.csv)
2. Editor window: Edit-> Find and Replace - Remove double quotation marks
3. File > Save as (typeperfM.csv)
4\ MATLAB
File Edit Wiew Debug Desktop ‘Window Help
D@ | & By @ v o ﬁﬁ@ @ Curre
Shartouts [F] How to Add [Z] What's Mew
Current Directory - C:\Documents and ...
=g @ a T File Edit Text Go Cel Tools Debug Desktop Window Help
All Files File Type | Si.. D - é{) E i é M P D ﬁ QC’DDID@
[ codel.m Mfle 2. o = & - Sk
[ codez.m Il-file 1. 1 "{PDH-C3V 4.0) (Eastern Standard Tiwe) (300)", "™\ \WORCETER-D17QY
b typeperfl.cs = B—C 2 "11/06/2006 18:33:01.957","99.996755430252207", 16", "11000000"
L=}
B typeperfi M. s 38.. 3 "11/06/2006 15:33:03.078","41,9642585714285708", 714", "11000000"
B typeperf2hd. | 24 4 "11/06/2009 Find & Replace i
5 "11/06/200¢4 ar
Cpen as Text & "11/06/ 2006 Find what: ..| v or
Open Outside MATLAB " . "
7 "11/06/ 2008 Replace with: — Ja
Irnport Daka,.., 5 "11/06/2008 ) ",
Hew ] 5 ri1/06/2004) 00k Edfitor - Current File (typepertl cev) v o
Parnren 10 "11/06/20084 ar
11 "11/06/20084 ar
12 "11/06/2008| [] Match case [ vwhole word [ Wirap around or
13 "11/08/200 7 7 7 ar
14 "11/06/2006 18:33:16.257","15.044247787610621", "17", 7110000007
15 18:33:17.329", "86.915887350467286", "17", "11000000"

r11/06/20086

2. Import Data in Matlab

A
%

importdata(‘typeperfM.csv’) ;

load data into a structure

- Structure A with two fields:
—->A.data
—>A.textdata (text data)

(numeric data)

% & Array Editor - A
File Edit Wiew Graphics Debug Deskbop Wil

Marme
A B | &4 B2 | & | [ - | ta | Steck
[ed T Field! Yalue

ans data < ioubles
H 1399 doub
colorPiot  |kextdata <140:20 celf

dataEx
Mo i

importdata

Load data from disk file

Syntax
importdata('filenames')
o imporcdata(' filenawe')
importdata('filensme', 'delimiter!')

Description

importdata (' filensme') loads data from £ilename

loads data from £i le:

n itportdata (' filenawe')

A loads

importdata (' filenawe','delimitcer!')

Array Editor - A.textdata
File  Edit

g 4 BB & [t steck
1 2

|'(F'DH-CSV 4.0) (Eastern Standar.. " WWYORCETER-D17 QY E\Processor(0)h. .
|'1 1/06/2006 18:33:01.957

|'1 1/06/2005 18:33:.03.078

|'1 1/06/2006 18:33:04.400

|'1 1/06/2006 18:33:.05.442

|'1 1/06/2006 18:33:065.483

Wiews Graphics Debug Desktop Window Help

m | | (W (R
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2. Import Data in Matlab A = importdata(‘typeperfM.csv’);
Col1l Col 2 Col 3 Cgl 4

A

Editor - C:\DocunLnts and Settings‘\ahera\Deskt p\CS\typeperHMksv
File Edit Text Go

-

el Tools Debug Deskiop ‘Windo Help

SECEEF— 2N W N € X B @ E B 8| stk

1 | (PDH-CSV 4.0} (Eastern Standard Tiwe) (300) , %\ VORCETER{D17QYE
8 11/06/2006 18:33:01.957 , |99 9975543025220 | 18 |, | 11000000 ,
3 11/06/2006 18:33:03.078 , |41.964285714285708| ,| 14 |, | 11000000|,
4 110672006 18:33:04.400 ,|31.060606060606055 ,| 16 |, | 11000000/,
5  11/06/2006 18:33:05.442 ,|6.7307692307692291| ,| 16 |, | 11000000/,
6 11/06/2006 18:33:06.433 , |23.076923076923073| ,| 15 |, | 11000000/,
7 11/06/2006 18:33:08.025 , |57.792207792207797 | 16 |, | 11i000000| ,

il s - .
Arriq.r Editor - A.textdata : Array Editor - A.data

File Edit “ew Graphics Debug Desktop  Window Help I
. X File Edit View Graphics Debug Desktop Window  Held
g 4 BB S -\ sex d ==
1 2 . EE & B & - | tm | Stack:
1 |'(F'DH—CSV4.EI) (Eastern Standar... | WWORCETER. . 1 3 3 4
2 |'11fDEQDDE1B:33:D1.95?' [
3 |11/06/2006 18:33.03.078 (1 1 89 9963 16| 11000000 1274 307
4 |[11/06/2008 13:33:04.400 [ 2 41 9643 14| 11000000 5641072
3 I'11MEQDDE18:33:05.442' [ 3 31.0606 16| 11000000 B202.594]
4 B.7305 16| 11000000 EBE33.561
—~>A.textdata (text data) == — Sess—ss
3. Process Data
datenum datestr
Convert date and time to serial date number Convert date and time to string format
Syntax Syntax
N = datenum(3) 3 = datestr (V]
N = datenum(S, F) % = datestr (]
53 = datestr (D, F)
1
1 |[{PDH-C3Y 4.0) (Eastern Standar.. |’
2 110822006 18:33:01 957
3 (11062006 15:33:03.078
4 |11/06/22006 18:33:04 400 T =
5 (11062006 15:33:05.442 1 Tin_ Sec msec
oCoc
timeDate=A.textdata(2:end,1); % time data 001121
timeUTC=datenum(timeDate); % transform time to UTC I B

relUTCTime=timeUTC-timeUTC(1); % define relative time [HIISA54

T=datestr(relUTCTime, °"MMSSFFF"); % time in minutes, seI:":| i
OO0 E0ES




4. Plot Data o Figuret
—<— typeperflM.csv
30 typeperf2M.csv 4
g ¢
3
204 ! ! W 4
I }%Mff@@\fé@fs@@&%@wﬁ\ Y Reonfupefy W“@ v
¥
10 1 1 1 1 1 1 1 1
0 20 40 60 80 100 120 140 160 180
Time
x 10 Figure2
1.1 T T
1.1¢ 4
<
5 4
o
1.1F B
1_ 1 1 1 1 1 1 1 1 1
0 20 40 60 80 100 120 140 160 180
Time
Figure3
80 T T
60 . 4
[ce)
5 40+ | 4
8 4
a 1
0 20 40 60 80 100 120 140 160 180

Time
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1. Data Preparation

1. Open as Text (logFile.dat)

2. Editor window: Edit-> Find and Replace > Remove [00-01-36-0D-CE-5D]

3. File > Save as (logFileM.dat)

cF i) | @ -
11 Filess

) typeper2i.cav

B typeperfli.cay

B typeperfl. ooy
coded.m
; codel.m
=] logFile. det

File Edit Text Go Cell Tools Debug Desktop Window Help

Dl it bloc| S dedf B0 BRE BB s

Open

Current Directory - C:\Documents and ...

File Type
CEW F.
CEWF.
CSWF.
fl-file
fl-file

AT l:i|E

1 UTCTime Signal St th T i ttedF tCount Multicast
. 1me lgna reng ransmil = ragmen oun 1 1lzas Open a5 Text
3 1162855979.864 —-43 0 153206 0 0 0 0 0 0 0 ol o aoudoOReROutside MATLAB
4
5 1162855 0 0 0 6604808 [00-01-36-0D-CE-5D]
& Find & Replace
; 1162855 Fin what | 105.01-35.00-CE.5D] -v_ 0 0 0 6604834 [00-01-36-0D-CE-5D]
9 11a2555]| onlace with: > 0 0 0 6604847 [00-01-36-0D-CE-5D]
T o 2

S Edltar - Currert File (logFile dat) | %
11 1162855 L 0 0 0 6604847 [00-01-36-0D-CE-5D]
1z Replace Al
13 1162855 0 0 0 6604855 [00-01-36-0D-CE-5D]
14 |:|Match case DWhoIe seare] DVWap around
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2. Import Data in Matlab

dataExp=dImread(logFileM.dat",

Array Editor - data

Row no

____, Colno

T, 1, 0);

dimread

Read ASCIl-delimited file of numeric data into matrix

File Edit “ew Graphics Debug Desktop Window Help
im| 4 Bl & ~ | T | Steck Graphical Interface
g 2 £ 2 As an alternative to dlmread, use the Import Wizard. To activate t
1| 1162855979.5864] -43 0 153206
2 11628555580.374 -43 0 153217
Syntax
3 1162855580 905 -39 0 153217 Y ]
4 1162555981408 45 o 1537 ﬁ = gimreagi :?iename ! S
= wmread('filename', delimiter
€ 11628553581 916 -48 d 153217 M = dlwread('filename', delimiter, B, <)
- AAC0EE0T 44T =) nl AE2717T
M = dlmread('filename', delimiter, range)
3. Process Data
timeUTC=dataExp(:,1);
relTime=timeUTC-timeUTC(1);
39
3. Plot Data & Extract Info
u Figure 20 g@@
File Edit View Insert .Tools Desktop  Window  Help ~
D& | Edtro || & o
2o Figure XX
234 Zaom Cut : : y . :
Rotate 30
-36 e ol ¢4 ssooe
Reset Yiew
=36 - (ptions »
Pin ko Axes
A0 W Snap To Layout Grid
i Wiews Layout Grid K o
2 42 Smart Align and Distribute d}‘ DS CISTCS S E]@
Align Distribute Tool ... Statistics for | logFileh dat W
Align 4 et — .
44 H Distribute » Check to plot statistics on figure:
Basic Fitting Bt L !
46 11 Diata Statistics i oL -8 |
THE maix 169.2 | ] -35 [ ]
U“ r! “ FEsn 7366 ||| -39.06 |[ |
48 L L ! L median 59.71 | 37
0 20 40 60 80 mode 0 |C] e
Time | g 47.24 ] 4,029 ]
range 169.2 13
Save to workspace... ] [ Help ] [ Cloze ]
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Processing Experimental Data for the Project

>

W DN PF

Data Preparation
Import Data in Matlab
Process Data

Plot Data

Files: typeperfl.csv, typeperf2.csv, etc codel.m

Files: logFilel.dat, logFile2.dat, etc code2.m
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